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GENERAL

Wemusic Instruction

Firstly we would love to send our great thanks to you for purchasing Wemusic.
This documentation covers almost everything to guide you step by step from the
start to have your site on air. We encourage you to read thoroughly all section
before you go on. If you still have to cope with any problem around, get our quick
support at NooTheme Support Center.

Thanks again and enjoy building your website with Wemusic.

WordPress Information

Before installing this theme, please make sure you have a working WordPress
version already installation. For further guide to install WordPress, please find in
below useful links:

e WordPress Codex: General info about WordPress and how to install your
server.

e Instructional Video: How-To video created by Woo Themes
e First Steps With WordPress: Multiple topics about WordPress.
e FAQ New To WordPress: Popular FAQs about WordPress.

Download Theme Package

When purchasing successfully our theme from Themeforest, you will need to
download theme package for your use. To download the package, please login to
your Themeforest account, navigate to “Downloads”, click the “Download”
button in the left of the theme, choose “All files & documentation” to download
our theme package to your computer. The theme package includes:

e Wemusic Theme File: Includes noo-wemusic.zip file that consists of
everything you need to install the theme.

e Document Folder: Includes Wemusic Documentation file that helps you
get to know about Wemusic and guides you to build your site with our
theme.

e Licensing Folder: Includes the licensing files of Themeforest purchase.


http://support.nootheme.com/
http://codex.wordpress.org/Installing_WordPress
https://vimeo.com/17147778
http://codex.wordpress.org/First_Steps_With_WordPress
http://codex.wordpress.org/FAQ_New_To_WordPress

Demo Content Folder: Includes the .xml file you will need to import our

demo data.

Requirement For Wemusic

To use Wemusic theme, you must be running WordPress 3.5 or higher, PHP5 or
higher, and MySQL5 or higher. Follow below checklist to ensure your host can
work well with Wemusic theme:

Your web host has the minimum requirements to run WordPress.

They are running the latest version of WordPress.

You can download the latest release of WordPress from official WordPress
website.

You did create best secure passwords FTP and Database.

INSTALLATION

There are two ways to install the theme. It is up to you to choose your preference.

Install Theme via WordPress
How to Install Wemusic via WordPress

Step 1: Login to your WordPress Admin Panel, navigate to Appearance—>
Themes

Step 2: Click Install Themes on the top = hit Upload button.

Step 3: Find “noo-wemusic.zip” file on your computer and click “Install
Now”.

Step 4: Once uploaded, activate the theme. Go to Appearance—> Themes
and activate it.

Step 5: Then you will see a notification message to activate the required &
recommended plugins: Contact Form 7, Revolution Slider, Visual

Composer. Follow the steps to install and activate each plugin.
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Note: If you see this message “Are You Sure You Want To Do This” when
installing noo-wemusic.zip file via WordPress, it means that you have an upload
max file size limit. Try to install the theme via FTP instead, or contact your host to
increase the limit.

Install Theme via FTP
How to install Wemusic via FTP

e Step 1: Login into your hosting space via a FTP software.

e Step 2: Unzip the noo-wemusic.zip file and ONLY use the extracted
Wemusic theme folder.

e Step 3: Upload the extracted Wemusic Theme folder into wp-content>
themes folder.

e Step 4: Activate the newly installed theme by going to Appearance—>
Themes and clicking the Activate button.

e Step 5: Then you will see a notification message to activate the required &
recommended plugins Contact Form 7, Revolution Slider, Visual
Composer. Follow the steps to install and activate each plugin.



Plugin Installation
Here is list of plugins that will come together with our theme when you activated

it. You are recommended to install and activate these plugins base on your own

need:

1. Visual Composer: The popular drag and drop page builder plugin with
intuitive interface to build your content at ease. Save another $33 for this
plugin with Wemusic.

2. Contact Form 7: Wemusic is fully compatible with Contact Form 7, the free
form plugin recommended to create a nice form for your site.

3. The Event Calendar: This plugin is a carefully crafted, extensible plugin that
lets you easily share your events.

After installation Wemusic theme, you will see a notification message to activate
the required & recommended plugins. Follow the steps to install and activate
each plugin.

If you want to install another WordPress plugin that doesn’t include in our theme.
Please following these steps:

e Step 1: Navigate to Plugins=> Add New.

e Step 2: Under Search, type in the name of WordPress Plugin or descriptive
keyword, author, or tag in the search form or click a tag link below the
search form.

e Step 3: Find the WordPress Plugin you wish to install

- Click Details for more information about the Plugin and
instructions you may wish to print or save to help setup the
Plugin.

- Click Install Now to install the WordPress Plugin.

e Step 4: You will see the popup window that will ask you to confirm your
wish to install the Plugin.

e Step 5: If this is the first time you've installed a WordPress Plugin, you may
need to enter the FTP login credential information. If you've installed a
Plugin before, it will still have the login information. This information is
available through your web server host.



e Step 6: Click Proceed to continue with the installation. The resulting
installation screen will list the installation as successful or note any
problems during the install.

e Step 7: If successful, click Activate Plugin to activate it, or Return to Plugin
Installer for further actions.

Import Demo Content
How To Import Wemusic Demo Content

e Step 1: From Admin Panel, after installing and activating our theme,
navigate to Tools, choose Import=> WordPress.

e Step 2: Click Choose File and browse the demo content .xml file extracted
from the .zip file you can download from Themeforest following guide in
DOWNLOAD THEME PACKAGE section above. Click Upload file and import
to upload the file.

Note: If you have not installed Deme Importer Plugin, you may see the
notification message to install the plugin. Click Install Now to install and
move on.

e Step 3: You will first be asked to map the authors in the file to users on the
blog. For each author, you may choose to map to an existing user on the
blog or to create a new user.

e Step 4: WordPress will then import each of the posts, comments, and
categories contained in this file into your blog.

See guide to import a sample content into a WordPress blog in WordPress Codex.

Note: Not all the content in our demo will be included. Those files might be
excluded from the content you can import:

e Images: our stocks might not be in the content due to license issues.
Instead, we replace with grey images. Please change to your own pretty
images for your site.

e Sliders, Post and Pages: not all sliders, posts and page in our demo will be
consisted in our dummy date when you import. However, we still add some
sliders and pages for your reference.


http://codex.wordpress.org/Importing_Content#WordPress

Basic Setting

If you’re new to WordPress, you’ll probably see that your site after importing data
is completely different from our demo. It's because some basic setting is needed
on WordPress site. If you know the problem is and how to fix it, please skip this
section.

Setup Home Page
To set up home page, please follow these steps:

e Step 1: Navigate to Settings=> Reading tabs.

e Step 2: Select A Static Page option.

e Step 3: Choose the page you want as your home page from the Front Page
dropdown list.

e Step 4: Here you can also select a page to display blog post from the Post
page dropdown list.



Front page displays Your latest posts

e A static page (select below)

Front page: Home v

Posts page: Blog v
Blog pages show at most 10 posts
Syndication feeds show the .

10 items
most recent
For each article in a feed, o Full text
show
Summary

Search Engine Visibility ¥| Discourage search engines from indexing this site

It is up to search engines to honor this request.

Save Changes

Assign Menu

Please go to Appearance—> Menus then find Menu Settings=> Theme Locations
at the bottom. Check the Primary Menu then save it. This action will assign the
menu “Main Menu” to the location Primary (the main menu) on our theme. You
can see more detail at: http://codex.wordpress.org/Appearance_Menus Screen

Change Permalink

Please go to Permalinks setting: Settings=> Permalinks then change the Common
settings to Post name. You can see more detail at:
http://codex.wordpress.org/Using Permalinks. After doing these steps, your site
will look like our demo, you can move on to process to build your content.



http://codex.wordpress.org/Appearance_Menus_Screen
http://codex.wordpress.org/Using_Permalinks

Update Theme
First way: Manual update

There are 3 methods to update the theme:

1.

Manually via WordPress admin: After downloading the package from
Themeforest, you can delete the old theme and install the new theme. All
your settings with our theme will be preserved but it sometimes results in
losing Menu or Widgets settings because this method actually switches
on/off the menu and widget location which has been registered by this
theme.

Manually via FTP: After downloading the package from Themeforest, you
can extract it and using FTP client like FileZilla to remove the old theme and
upload the new theme. With this method, all your settings, including the
menu and widget will be persevered.

Using Envato WordPress Toolkit introduced on this link:
http://premium.wpmudev.org/blog/how-to-update-themeforest-
themes-with-the-envato-wordpress-toolkit/. This is the plugin developed
by Envato to auto update WordPress theme bought in Themeforest.

Second way: Automatic Update

Please follow these steps to update theme:

Note:

Step 1: Hover into username then choose Download

Step 2: Select "License certificate and purchase code"

Step 3: In Admin Panel, choose Settings, click “NOO Wemusic License”. You
will see the message Please enter your license key to enable updates to
NOO Wemusic.

Step 4: Enter code into License key

Auto update is available from version 1.0.0 and above


http://premium.wpmudev.org/blog/how-to-update-themeforest-themes-with-the-envato-wordpress-toolkit/
http://premium.wpmudev.org/blog/how-to-update-themeforest-themes-with-the-envato-wordpress-toolkit/
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THEME CUSTOMIZER

Our Theme customizer works as the original WordPress customizer feature but be
much more versatile. All our theme options can be changed in our Customizer on
the left side and live previewed instantly on right side. With this intuitive
interface, you can customize your website as you wish at your fingertips without
writing a line of code.

To start using Customizer in Admin Panel, navigate to Customizer, you will be
redirected to a live preview screen where you can change options on left side and
preview your site on right side promptly. All your change will not be committed
and viewed on your site until you click Save & Publish on top right of Customizer
bar. You also are able to Export your setting in Customizer and Import to apply
for other sites.

Site Enhancement
e Custom Favicon: A favicon is a simple square image viewable in browsers
for users to identify your website among many tabs. Ideally, it should be a
32x32 pixels or a 16x16 pixels. Most modern browsers can display a favicon
in PNG format but older versions of Internet Explorer may not. To make
sure your favicon be shown nicely, it is recommended to be in .ico format.
Add your favicon in our customizer simply by clicking “Open Library”



button in “Custom Favicon”, selecting your existing image or uploading
new image.

Back To Top Button: Back To Top Button will appear in the right bottom
when users scroll down. Enable/Disable as your preference.

Enable Page Heading: Page Heading will appear on the header of page.
When you Enable this option, you will have header background image on
blog-page, department-page, doctor-page.

Enable Breadcrumbs: Breadcrumbs will appear below header title of page.
Enable/Disable as your preference.

Enable MailChimp Settings: This option allows you to turn on MailChimp
Subscribe. You need to add MailChimp API key to connect your account. To
learn more about MailChimp API key you can go to HERE.

Design and Layout

Style Layout: This option will help you set Style & Layout for your site. We
provide two layout styles, include: Boxed Layout and Fullwidth layout. With
Boxed layout, you will have additional options for max site width,
background color or image setting.

Color: This option allows you to set the color for links and various elements
for your site.

Primary Color: you can change primary color by this option. There is
table of color, which allows you to select color you want or enter
your color code on box.

Typography
You can customize your Typography settings here. Wemusic integrated all Google
Fonts. See font preview at Google Fonts.

Custom Fonts: Enable Custom Fonts to customize font, font size and other
settings for heading and body text.

Custom Font Color: Enable Custom Font Color to customize font color of
heading and body.

Headings: If checked on Transform to Uppercase, you will have heading
<h1> <h2> <h3> which is uppercase type.


http://kb.mailchimp.com/accounts/management/about-api-keys
http://www.google.com/fonts/

e Body: You can change font size of body by selecting font size from
dropdown list.

Header
Customize settings for Heading including Navigation Bar, Logo and NavBar
Alignment.

Navigation Bar
This section adjusts settings for Navigation Bar. You also can customize some
settings for the Toggle Button on Mobile in this section.

e NavBar Position: This option allows you to select type of NavBar, including
Static Top or Fixed Top.

e Show Shopping Cart: This option allows you turn on/off shopping cart
button on the main menu.

e Use Custom NavBar Font and color: If On, you can change font, font size,
link color and link hover color for header font. If you click on Transform to
Uppercase checkbox the NavBar will transform Uppercase.

Logo
Wemusic allows to add image file or use text for logo. You will see button to turn
On/Off Use Image for Logo.

If Off, you will have option to enter your site name, select logo font from
Google font, font size and color for your logo.

If On, you will have two logo images to upload. The first one is for standard
desktop while the second one is for retina ready devices (optional). Click
the Upload button and select your logo file. Upload your logo image and
retina one (a larger image, with double the amount of pixels that your
image will be displayed at). Enter your image height you want to display on
navigation bar and we will do the calculation part for you to make it look
great on all screen size.

NavBar Alignment
Adjust height of navigation bar, space between links and size of mobile navigation
button.



Footer
Footer contains Widgetized area and Footer Bottom. You can change any parts.

e Upload Your Footer: You can upload one image from Media Library or your
computer for footer.

e Footer Columns (Widgetized): This option allows to set the footer column
number from drop-down list. Number of columns can be from 1 to 4. You
also can select None to leave it blank (no footer content).

e Footer bottom: You can turn on/off footer bottom for your site.

e Footer Content (HTML): Enter your content for Top Footer. You need to
add content by Custom HTML content.

Widgets

This section enables you to add and customize Widgets on you preview site. It
includes number of Footer Columns due to setting in above section: Footer
settings.

Footer Column #i: You will see number of footer columns corresponding to footer
settings. Add text, image or other widget by hitting Add a Widget button.

Blog

Post List
Choose layout settings for your Post List.

e Blog Layout: It can be full-width, with right sidebar and with left sidebar. If
you choose layout with sidebar, select blog sidebar for your blog page.

e Blog sidebar: Choose sidebar for your blog page.

o Heading Background Image: You will have background image of blog page
if you click “Select Image” button then select image from Library or
choosing from your computer.

e Show Post Meta: Check the box to show post me-ta of blog page.

e Show Read-more link: Check the box to show read more link.

e Excerpt Length: The number of character displayed on post selection.

Single Post
e Post Layout: Choose Post layout same as blog layout by checking the boxes
beside options or uncheck to choose another layout.



e Show Post Meta: If checked, post me-ta will display on each post. Similarly,
you can choose show/hide post tags and author’s bio.

¢ Enable Social Sharing: Enable/Disable Social Sharing. If enable, you enable
visitor to share your post by Facebook, Twitter, Google+, Pinterest and
LinkedIn.

Event
This section will help you set up all settings for Event page.

e Upload Image heading: You will have header image of event page if you
click “Select Image” button then select image from Library or choosing
from your computer.

Album

This section will help you set up image heading and choose Footer player. You will
have three options here:

e Enable on all pages: If you check this box then you will have footer player
displayed on all the pages

WEMUSIC

e Only Enable on Single Album: If this box is ticked then footer player will be
shown on Single Album page



SINGLE ALBUM

TRACKLIST

1 Forever And One
Beatiful In White
3 Glad You Came
4 NoFace No Name No Number
S Ouando Ouando

6 Payphone

Happy music day

e No Player: If this box is checked, footer player will not be displayed in any
pages

Woocommerce

Shop Page

This section provides some options which will help you to choose Layout and
Headline settings for your Shop page.

e Shop Layout: You can choose different layout for Shop page, including Full-
Width, With Right Sidebar or With Left Sidebar. If you choose layout with
sidebar, select shop sidebar for your shop.

e Heading Background Image: You can choose Heading Background of Shop
page by clicking “Select Image” button and then enter title for Shop page.

e Products Per Page: You can set number of products displayed per page.
Limited on 4 to 50 products.

Single Product

Same as with Shop Layout you can choose Layout for Single Product. Besides that,
you can enter number of Related Products Count.

Custom Code

In this section you can add custom JavaScript and CSS to your site. You Google
analytics tracking code should be added to Custom JavaScript field.



Import/Export Setting

All themes from NooTheme share the same theme settings structure so you can
export then import setting from one theme to another conveniently without any
problem.

e Import Settings: Click Upload button then choose a JSON file (.json) from
your computer to import setting to this theme. All the settings will be
loaded for preview here and will not be saved until you click button “Save
and Publish”.

e Export Setting: Simply click Download button to export all your settings to a
JSON file (.json). You then can use that file to restore theme settings to any
theme of NooTheme.

HEADER
Adding Logo

Wemusic allows you to add image file or use text for logo. For the image file, you
can upload at any size and it will be adjusted to fit into the menu. There is an
option for you to upload a retina logo to keep your logo retina ready.

e Step 1: Navigate to Customizer=> Header—> Logo tab to access the logo
options.

e Step 2: You will see a button to turn On/Off Use Image for Logo.
If Off, you will have option to enter your site name, select logo font from
Google font, font size and color for your logo.
If On, you will have two logo images to upload. The first one is for standard
desktop while the second one is for retina ready devices (optional). Click
the Upload button and select your logo file.



Step 3: If you are uploading a retina logo (optional), you need to upload a
larger image of which dimensions are 2 times larger than dimension that
your standard logo will be displayed.

Step 4: If you are using a retina logo, you must enter the logo height for
standard logo.

Setting Up Menu

Wemusic supports custom WordPress menu, this is one area where you can
assign a menu: Main Menu. Following the guide below to learn how to create new
menu on Wemusic theme.

Step 1: Navigate to Appearance=> Menus from Admin panel.

Step 2: Click the Create A New Menu link to make a new menu. Enter the
name then click Create Menu button.

Step 3: To add menu item, select pages and post on the left hand side and
click Add to Menu button. You also can add custom links or post categories
into menu.

Step 4: To create a dropdown menu, simply drag a menu item below of
another menu item and slightly to the right, and it will lock into place and
create a dropdown section.

Step 6: After setting up your menu, scroll down to the bottom of the page
to assign the menu on the Theme Location box.

Step 7: Once it’s all done, make sure you click the Save Menu button.

Below is the screenshot of menu structure and place to assign menu:
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Delete Menu

In this section, you will find how to create a new page and number of important
page of Wemusic using our shortcode and widgets. We also did some change to
the default WordPress page setup by adding some page templates and preset
options for you to build your page fluidly.

Create New Page
Please follow these steps to create your pages:

e Step 1: In Admin Panel, choose Page, click “Add New” on top then enter
your page title. You can custom slug of the page in Permalink field
appeared after entering title.

If you need to know more about Pages in WordPress, use the Help tab in
the upper right of your screen.


https://codex.wordpress.org/Pages

e Step 2: In Page Attributes box on the right side, choose your Parent page. It
is set by default as no parent. Pages are usually ordered alphabetically, but
you can choose your own order by entering a number in Order field.

e Step 3: Also in Page Attributes box, choose your Page Template in
dropdown list. See below Page Template list for more detail.

e Step 4: Start editing your page content in the editing field. You can choose
to edit your content using Visual or Text editor. To build content for you
page you will need to our provided Shortcodes.

e Step 5: Make other settings for the page in meta-boxes under editing field.
Once you get your settings done, click Publish your page.

) Dashboard Pages Add New
Posts You have venues for which we don't have Geolocation information. Click her
Events
Team Member All (13 Published | Drafts(2) | Trash (2
Bulk Actions ¥ | Apply Alldates ¥ | Filter
Title

(no title) - Draft

Add New

Blog - Posts Page
Comments (1

[ ]

S
Lo Blog Masonry
e

WooCommerce
. Cart
" Products
Appearance Checkout
Customizer
contact us

Plugins (2

Users
Home - Draft

Tools




Here is screenshot that shows you the various areas and description of the page
settings described above:

Screen Options Help

Add New Page

Enter title here Publish R

Save Draft Preview

&= Using the Visual Composer to . _
add shortcode here ¥ status: Draft Edit

<@ Visibility: Public Edit
0 Add Media
I = Vi | Text
5o b m Publish immediately Edit

B I »= = = 6 — E = = f R = B Revslider v =
Move to Trash m
Page Attributes A
Parent
(no parent) T
Set your Parent and Page Template here $=| Template
Default Template v
Order
0
Word count: 0 Need help? Use the Help tab in the upper
right of your screen.
Page Settings a
Featured Image .
Choose various setting for your Page.
Set featured image
Body Custom CSS Class
Hide Page Title Set individual page
&= options using the Page
Heading Background Image Settings here.
An unique heading image for
this page

We have built some specific Wemusic page templates for you. Here is the list and
their short description:

e Default Template: The default template can be used for any page. You
can customize and add shortcode to build Homepage, Contact, Blog...

¢ Full- width Template: This template is set to be full-width that can be
used for Homepage, About page....

e Page with Left Sidebar: You can have your page with left sidebar with
this template. Use this template for your blog or whichever page you
want to have sidebar. Select Page sidebar to display in sidebar position
in Sidebar box.



e Page with Right Sidebar: Also with sidebar but the right one, and of
course, its use is quite the same. Choose this template for your blog
whichever page you want to have sidebar. Select Page sidebar to display
in sidebar position in Sidebar box.

Page Settings

We have created some specific Wemusic page settings which will help you to
build splendid pages for your site. Following the list of options below to see how
they work:

e Body Custom CSS Class: Add custom CSS class to <body> elements.

o Hide Page Title: If you checked, page title won’t be displayed on header of
your page.

¢ Heading Background Image: This option allows you to select a unique
heading image for your page.

Create Contact page

If you want to create Contact page as in our demo, create a new page (You can
enter title: Contact Us), add 2 columns then add Contact Form 7 shortcode and
add Text Block shortcode with Custom HTML in each column:

<ul class="contact-info">

<li><span class="contact-title">VENUES</span><i class="fa fa-map-
marker"> </i>69 South Park Avenue San Francisco, CA 14782 USA</li>

<li><span class="contact-title">TELEPHONE</span><i class="fa fa-envelope-
0"> </i>support@companyname.com</li>

<li><span class="contact-title">EMAIL</span><i class="fa fa-phone">
</i>(00) 123 456 789</li>

<li><span class="contact-title">WEBSITE</span><i class="fa fa-globe">
</i><a href="#">www.companyname.com</a></li>

</ul>



BLOG

Wemusic supports 4 post formats. Follow below steps to create blog posts
assigned on blog page list.

Create New Post

Step 1: In your Admin Panel, go to Post and navigate to Add New.

Step 2: Enter your title and choose Post Format from Format box on the
right side which shows different post format options: Standard, Image,
Gallery and Video.

Step 3: Add your post content in editing field. You can use our shortcode to
build your content where needed.

Step 4: Add Categories for the post from the Categories box on the right
side. You can add new category or choose from existing categories. Check
the box to select Categories for your post. Add relevant Tags for your post
in the Tags box, set Featured image on the right side and other setting from
the sections below Editing field.

If you need detailed guide about post settings in WordPress, please find in
WordPress Codex.

Step 5: All done, click Publish to publish your post.



http://codex.wordpress.org/Posts_Add_New_Screen
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Blog Post Setting
Global Setting
e Body Custom CSS Class: Add a custom CSS class to the <body> element.
Separate class names with a space.

e Page Layout: You can choose Layout of Single Post page, includes Full
Width. With Right Sidebar and With Left Sidebar style.

Post Format Setting

e Gallery Settings: When selecting Gallery Format, you will have Gallery
Setting meta-box to add as many images as you want into your gallery and
manage your preview content as Featured Image, First Image on Gallery or
Image Slideshow.

e Image Settings: When you selecting Image Format for you post, you will
have Image Settings meta-box to choose main image of the post. Set
Feature Image as main image for preview content or Choose Your Image if
you want to set another image as main image for preview content.

e Video Settings: When selecting Video Format, you will have Video Setting
meta-box where you can add video URL, and embedded video code, aspect



ratio and preview content as Featured Image, Video or Featured Image as
Video Thumbnail.

e Quote Settings: When selecting Quote Format, you will have Quote Setting
meta-box where you can add quote and citation.

Assign Blog page
How to assign a page as blog page

e Step 1: Navigate to Pages—> Create New Page.

e Step 2: Enter a new name for your page, then find the Page Attributes box
on right side.

e Step 3: Select the Default page template from dropdown list.

e Step 4: Click “Publish” to save the page

e Step 5: To set the page as your post page, navigate to Settings=> Reading
and select your blog page name for the Posts Page. All your posts will be
automatically displayed on the page. You can set number of posts per page
in Reading Settings, too.



Reading Settings

Front page displays Your latest posts

* A static page (select below)

Front page: Homepage ¥

Posts page: Blog v
Blog pages show at most G posts
Syndication feeds show the .

10 items
most recent
For each article in a feed, o Full text
show
summary

Search Engine Visibility Discourage search engines from indexing this site

It is up to search engines to honor this request.

Save Changes

THE EVENTS CALENDAR

In Wemusic theme, we use The Events Calendar plugin which will help you to
create events, present event listing and event calendar. You can show your events
calendar in grid layout, list or day by day. You can set the default view and
optional views that visitors can choose from dropdown list and many more
available event settings.

Create A New Event
To create a new event, please follow these steps:



Step 1: Go to Dashboard—> Navigate to Events> Add New Event

Step 2: Enter title and description for event

Step 3: Choose Event Categories, Event Options and set Featured Image for
event. You can upload some image for Event Gallery, too.

Step 4: Scroll down your mouse you will see more field of event
information including Event Time & Date, Location, Organizer and Website.
Please fill out those information.

Step 5: Add tickets by adding new ticket button which customers can buy
ticket to join event.

Step 6: All done, click “Publish” to publish event.

The Event Calendar Setting

To see all settings of Event Calendar plugin, please navigate to Events—> Settings
you will see General/ Display/ Default Content/ Additional Fields/ Licenses/ and
Help tab. Please see this guide below to understand all settings:



General Tab



General Settings

Number of events to show per
page

Use Javascript to control date
filtering

Recurring event instances

Front-end recurring event

instances toggle

Clean up recurring events after

Create recurring events in advance

for

Show comments

Include events in main blog loop

Events URL slug

Single event URL slug

End of day cutoff

Default currency symbol

Currency symbol follows value

Map Settings

Enable Google Maps

Map view search distance limit

Map view distance unit

Fix geolocation data

Google Maps default zoom level

Miscellaneous Settings

Duplicate Venues & Organizers

Debug mode

View Welcome Page

View Update Page

Enable [ive ajex for datepicker on front end (User submit not required).

O
Show only the first instance of each recurring event (only affects list-style
views).

O

Allow users to decide whether to show ll instances of a recurring event.

24 months

Automatically remove recurring event instances older than this

24 months.

Recurring events will be created this far in advance

Enable comments on event pages.

Show events with the site's other posts. When this box is checked, events will
also continue to appear on the default events page.

events

The slug used for building the events URL Your current events URL is:

http: //wpth: com/noopress/wemusic/events,

event

The above should ideally be plural. and this singular.

Your single event URL is: http://wpth hemes . c opr

12:00am v

Have an event that runs past midnight? Select  time after that event's end to avoid showing the event on the next day’s calendar.

§

Set the default currency symbol for event costs. Note that this only impacts
future events, and changes made will not apply retroactively.

The currency symbol normally precedes the value. Enabling this option
positions the symbol after the value.

Check to enable maps for events and venues.

25

Set the distance that the location search covers find events within X distance
units of location search input.

Miles. v

Fix venues data

You have 1 venues for which we don't have geolocation data. We need to use
the Google Maps AP to get that information. Doing this may take a while
(aprox. T minute for every 200 venues).

10

0= zoomed out; 21 = zoomed in.

Merge Duplicates

You might find duplicate venues and organizers when updating The Events
Calendar from a pre-3.0 version. Click this button to automatically merge
identical venues and organizers.

O

Enable this option to log debug information. By defautt this willlog to
your server PHP error log. [f you'd like to see the fog messages in your
browser, then we recommend that you install the Debug Bar Plugin
and look for the “Tribe" tab in the debug output.

View Welcome Page

View the page that displayed when you initially installed the plugin.

View Update Page
View the page that displayed when you updated the plugin.

ic/event/single-post-name/



General Settings

¢ Number of events to show per page: You can enter the number of events
which are shown per page.

e Use Javascript to control date filtering: If checked, enable live ajax for
date-picker on frontend.

e Recurring event instances: If checked, show only the first instance of each
recurring event (only affects list-style views).

e Front-end recurring event instances toggle: Allow users to decide whether
to show all instances of a recurring event.

e Clean up recurring events after: Enter the number of months you want to
automatically remove recurring event instances older than this.

e Create recurring events in advance for: Recurring events will be created
this far in advance.

e Show comments: If checked, you can enable comments on event pages.

¢ Include events in main blog loop: If checked, you can show events with the
site’s other post. When this box is checked, events will also continue to
appear on the default events page.

e Events URL slug: Enter the slug here. The slug used for building the events
URL.

¢ Single event URL slug: Enter the slug here. The slug used for building the
events URL.

¢ End of day cutoff: Select a time from dropdown list after that event’s end
to avoid showing the event on the next day’s calendar.

e Default currency symbol: Set the default currency symbol for event costs.
Note that this only impacts future events and changes made will not apply
retroactively.

e Currency symbol follows value: Enable this option positions the symbol
after the value.

Map Settings
This section allows you to configure all options of Map.

e Enable Google Map: If checked, enable maps for events and venues.



e Map view search distance limit: Set the distance that the location search
covers.

e Map view distance unit: Select unit which map distance is shown. You can
choose Miles or Kilometers.

¢ Fix geolocation data: You have 1 venues for which we don’t have
geolocation data. We need to use the Google Map API to get that
information. Doing this may take a while.

e Google Map default zoom level: Enter the number that Google Maps zoom

Display Settings
The settings below control display of your calendar.
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Basic Template Settings

e Default stylesheet used for events templates: You can choose stylesheet
for your events templates. Including Skeleton Styles (Only includes enough
css to achieve complex layouts like calendar and week view), Full Styles
(More detailed styling, tries to grab styles from your theme).

e Events Template: Choose a page template to control the appearance of
your calendar and event content.

e Enable event views: That includes List, Month, Week, Day, Map and Photo.
You must select at least one view.

e Default view: Select View as default view from drop down list.

e Disable the Event Search Bar: If checked you can use the classic header.

¢ Hide location search: Removes location search field from the events bar on
all views except for map view.

e Hide related events: Remove related events from the single event view.

e Month view events per day: Enter the number that allows more than the
default 3 events per day in month view.

Date Format Settings

In this section you can enter the format to use for displaying dates with the year/
the month/ or the day.

Default Content

Choose the default venue & organizer. Set default address information to save
time when entering a new venue or organizer. You can override these settings as
you enter a new event.

WEMUSIC CUSTOM POST TYPE
ALBUM

Wemusic theme allows you to add album which visitors can listen and buy album
via iTunes, Amazon or Woocommerce. In addition, we provide some taxonomy
such as Album Artist, Genre, Producer and Tag which are displayed in right side
when you create new album in Dashboard.

Please see the guide below to learn more about Album section.



Create A New Album
To create a new album, please follow these steps:

e Step 1: From admin panel, navigate to Aloum—> Add New Album

e Step 2: Enter title and description of your Album

e Step 3: Choose Album Artist, Alboum Genre, Album Producer, Album Tag
and set Feature Image for your album.

e Step 4: Scroll down your mouse, you will see Album Settings section of
Album that includes Purchase Link Setting (The links to purchase album)
and Songs setting. Please fill out all information for sections above.

e Step 5: All done, Click “Publish” to save your album.

Dashboard A|bu

Posts You have venues for which we don't have Geolocation information. Click here t
] Events
s e F All (14) | Published (14) | Trash
Media Bulk Actions ¥ | Apply Alldates ¥ | Filter
Title

Pages

Comments @ Happy music day

=5 Album

Live on Letterman
Album

Add New Album

Hollywood bowl
Album Artist

Album Genre

Papagayo Beach Club
Album Produced pagay
Album Tag

Roseland Ballroom
B4 Contact

Create a New Artist/ Genre/ Producer
To create a new artist/genre/producer, please follow these steps:



e Step 1: From admin panel, navigate to Album—> Album
Artist/Genre/Producer.

e Step 2: You will see Add New Album Artist/Genre/Producer on the left
side, please enter name, slug, and description for Album
Artist/Genre/Producer.

e Step 3: All done, click “Add New Album Artist/Genre/Producer to save
information. The new album category/ genre/producer will be displayed on
the right side when you add new album.

Album Settings
e Purchase Link Setting: In this section you need to enter links to redirect
customer to sites they can buy your album that may include iTunes,
Amazon and Add to Cart URL.
e Songs Setting: You can set Release date of album and add songs of album
from your Media Library or your computer.

Create Album Masonry page

To create Album Masonry page, create a new page (remember to set title for
page) and add Product Masonry shortcode on page (You can configure some
options in this shortcode).

TEAM MEMBER

Create A New Team Member

e Step 1: From admin panel, navigate to Team Member—> Add New

e Step 2: Enter title and select categories for team member

e Step 3: Scroll down your mouse, you will see Team Member Information
and Social options. Please fill out information for Team Member
Information (Remember to select image for your team member) and add
your social in Social section.

e Step 4: All done, click “Publish” to save your team member.



) Dashboard Team Membe

He s You have venues for which we don't have Geolocation information. Click b
iin] Events
* Team Member All (9) | Published (¢
Bulk Actions T | Apply Alldates ¥ | Filter
Team Member
Add New Title
Team Categories Amaya
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Comments (1
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5 Album
Contact Tomaslau

WooCommerce
Adelle Charles

£ Products

Appearance Petter Land

Create Members page
To create Members page which shows all team members, create a new page

(remember set title for page) and add Noo Team shortcode on page. You can
configure some options in this shortcode.

WEMUSIC SHORTCODE

Instead of writing lines of code to build elements, we built Wemusic with number
of premade shortcodes that enable you to create many elements you see in our
demo in fingertips. By installing Visual Composer (the page builder plugin
integrated in the theme package), you will have the Visual Backend Editor where
every shortcodes are displayed visually before your eyes and easily generated in



several clicks. In addition to Default Visual Composer shortcodes, Wemusic comes
with 6 specific shortcodes. To generate the shortcodes, go to Backend Editor, click
the “+” icon to add shortcode. Navigate to Wemusic tab to find a shortcode you

want to use. You can add those shortcode to any pages or posts for your own use.

Blleidsal <— Switch to Backend Editor here

Visual Composer a

¢ |+ | EE 2%
<—— Add shortcode here

¢
Welcome to Blank Page, You Have No Content Yet!
Add Some Content or Use Predefined Layouts...

S —

Choose Your Layout

There are 12 custom Wemusic Shortcodes. Below are list 12 shortcodes and their
attributes:

padHemen x
All Content Social Structure WordPress Widgets WooCommerce WeMusic Deprecated
|shl | Noo Blog Masonry BB | Product Masonry 28 Album Masonry =% Responsive Slider % | Noo CountDown i=  Noo Events List 28 Noo Events Grid
Moo Featured . .
—
@ Albums E Noo news Blog +— Noo Services I& Noo Line @ Noo Team

Use this shortcode if you want to build Blog Masonry page.



CROSSROADS FESTIVAL 2013 REVIEW

/—*‘):} .

o

Lorem ipsum dolor sit amet, consectetur adipiscing elit. sed
do eiusmod tempor incididunt ut labore et dolore magna

aliqua. Ut..

THE BLACK KEYS LIVE AT COLLACHE

Lorem ipsum dolor sit amet, consectetur adipiscing elit. sed
do eiusmod tempor incididunt ut labore et dolore magna

aliqua. Ut...

SIXTEEN SALTINES

Lorem ipsum dolor sit amet, consectetur adipiscing elit. sed
do eiusmod tempor incididunt ut labore et dolore magna

aliqua. Ut.

BACKSTAGE AT COACHELLA

>

Lorem ipsum dolor sit amet, consectetur adipiscing elit. sed
do eiusmod tempor incididunt ut labore et dolore magna

aliqua. Ut




Detail options

e Categories: Select categories of which blog posts will be displayed on blog
page.

e Title: Enter text which will be used as element title. Leave blank if no title is
needed.

e Order By: This option will help you arrange your posts following different
order criteria including Recent First, Older First, Title Alphabet, and Title
Reversed Alphabet.

e Post per page: This option allows you to choose the number of post will be
displayed per page.

e Columns: Number of post columns. The column attribute controls the
width of columns should be displayed on Blog Masonry page.

e Excerpt Length: The number of characters displayed on post selection.

Noo Count Down
This shortcode allows you to have count down feature on slider of homepage.

OUR LATEST EVENT IS READY NOW!

XPERIENCE PREMIUM MUSIC BAND EVENT WITHTONS OF FEATURES WITHIN MINUTES. EVENTS ARE
READY-TO START AND WAITING FOR YOUR CHOICE

13 47 46

HOURS MINUTES SECONDS

DISCOVER NOW

Detail option:

General

e Choose date: This option allows you to choose date when event arrives.
You can choose one day from the calendar.

e Title: Enter title of shortcode here.

e Button name: Enter name of button.



e Button Link: Enter link of button which visitor can click and see all
information of event.
e Description: You can enter the short description that describes your event.

Design options

e Background Style: You can choose 3 background styles for shortcode that
includes Parallax style, Slider style and Video You-tube style.
If choose Parallax style, please select your image by click “+” button to add
your image.
If choose Slider, you still click “+” button to select some images for slider.
If choose Video You-tube, please enter You-tube video link to add video
from You-tube.

e Overlay: Choose overlay color from color table or enter code of color you
want for box.

e Height Style: Choose height style for shortcode including Full Screen and
Custom Height. With Custom Height option, you need to input height on
box.

Noo Events List
Use this shortcode if you want to display all event or one event category on page.



UPCOMING

New events are coming along with new surprises and scales. Find out your favorite one in the collection and enjoy the moments with us.
Bring inspiration for music band and fan isthe key mission.

ROCKNESS FESTIVAL
JUNE19-7.00 PM-JULY 21-11:00 PM GRAMERCY PARK HOTEL, NEWYORK

LIVE AT OZZFEST
JUNE 1-8:00 PM-AUGUST 6-11:00 PM GRAMERCY PARK HOTEL, NEWYORK

LOLLAPALOOZA FESTIVAL

JUNE 1-8:00 PM-SEPTEMBER 30-11:80 PM GRAMERCY PARK HOTEL, NEWYORK

Detail option:

e Title: Enter title for shortcode here.

e Description: You can enter short description here.

e Order By: This option will help you arrange your post following different
order criteria including Recent First, Older First, Title Alphabetic and Title
Reversed Alphabetic.

e Limited: The maximum number of post will be displayed on slider.

e Button name: Enter name of button.

e Button Link: Enter link of button.

Noo Event Grid
Use this shortcode if you want to show all or one event category in grid style.

DOCUMENTATION CREATED BY: NOOTHEME



SUCCESSFUL EVENTS

@ Catch up the mosthighlighted moments of our successful events and believe that we can do best thanever.
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Detail option:

e Choose icon: Select one icon for shortcode from list icon.

e Title: Enter title here.

e Description: Enter short description for shortcode.

e Choose data: Choose event categories which events will be displayed on
your page.

Noo News Blog
This shortcode will help you to get blog posts on page.



NEWS AND UPDATES

We create posts and news with useful information for event overview, tips and trends, highlighted moments and videos to give you the best visualization of
what we have done over time.

WHY WE CREATE MUSIC

Lorem ipsum dolor sit amet. consectetur adipiscing elit. sed do eiusmod tempor incididunt
ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud exercitation

ullamco laboris nisi

CONTINUE READING

THE ROLLING STONES AT HYDE PART

Lorem ipsum dolor sit amet. consectetur adipiscing elit. sed do eiusmod tempor incididunt
ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud exercitation

ullamco laboris nisi

Detail option:

e Choose icon: Select icon you want from list icon.

e Title: Enter title of shortcode here.

e Description: Enter short description for shortcode.

e Data Source: That includes Category, Posts, and Tags.

If choose Category you can select categories that posts will be displayed on
your page. Similarly with Tags.

If choose Posts, you need to enter title of posts on box to pick certain posts.



e Order By: This option will help you arrange your post following different
order criteria including Recent First, Older First, Title Alphabetic and Title
Reversed Alphabetic.

e Posts Per Page: This option allows you to choose the number of post will be
displayed per page

e Excerpt Length: The number of characters displayed on post selection.

Noo Line
This shortcode will help you to have a line on page.

Noo Services
Use this shortcode if you want to show list icon on page.

4 e %

BOOKING TICKETS EASILY LIVE MUSIC PLAYER QUICK CONNECTION

Lorern ipsurn dolor sit amet, consectetuer adipiscing Lorern ipsurn dolor sit amet, consectetuer adipiscing Lorern ipsurn dolor sit amet, consectetuer adipiscing
elit. sed diam nonummy nibh evismod tincidunt ut elit, sed diam nonummy nibh evismod tincidunt ut elit, sed diam nonummy nibh evismod tincidunt ut
laoreet laoreet laoreet

Detail option:

e Choose icon: Select icon from list icon.
e Title: Enter shortcode title here.
e Description: Enter short description for shortcode.

Noo Team
Use this shortcode if you want to build Member page.

e Title: Enter title here.

e Description: Enter short description for shortcode.

e Categories: Select categories which team member will be displayed on
frontend.

e Order By: This option will help you arrange your post following different
order criteria including Recent First, Older First, Title Alphabetic and Title
Reversed Alphabetic.



e Limited Team Member: This option allows you to choose the number of
team member will be displayed per page.

Album Masonry
This shortcode will help you to build Album Masonry page.

HAPPY MUSIC DAY LIVEON LETTERMAN HOLLYWOOD BOWL

o

PAPAGAYO BEACH CLUB ROSELAND BALLROOM BACARDI ORIGINAL BAR

Load More

Detail option:

e Product per page: This option allows you to set the number of albums
which will be displayed per page.




e Visibility: Select devices which albums will be displayed on your page. You
can choose Show/Hide on PC/Tablet/Phone device.

Noo Featured Albums
This shortcode will help you to get all albums that will be displayed on Homepage.

WOO COMMERCE

When Woo Commerce is installed in your site, you are able to create online shop.
Below this guide to create Product using Woo Commerce plugin.

Create A New Product For Shop

e Step 1: Navigate to Product from WordPress admin sidebar.

e Step 2: Click Add New to make new product. Create title and insert your
product content in the editing field.

e Step 3: Add Categories from right side. To assign it to the product, check
the box next to the category name.

e Step 4: Add Tags from the right side. Type the name of tags in the field.

e Step 5: Select featured image for product from hitting button “Set featured
images”. You can then select products images to add into Product Gallery.

e Step 6: Scroll down your mouse, you will see Product Data option.
Remember choose Product Data: Simple Product.

e Step 7: Once you have finished, click “Publish” to save product.

SIDEBAR

Wemusic allows you to create an unlimited number of sidebar. Each page or post
can come with unique sidebar.

To select a sidebar for post or page, make sure you set page template with
sidebar then you can choose a sidebar you want to display from Sidebar
dropdown list on the right side. You may need to create several separate sidebars
to use for different pages and posts. Follow these steps to generate a sidebar and
add widgets to it.



Create sidebar

e Step 1: Navigate to Appearance—> Sidebar Generator and click the Add
New button, enter sidebar title then save. You can add as many sidebars as
you need.

e Step 2: Once you are done, you need to add Widgets to the sidebar you just
created.

e Step 3: Navigate to Appearance—> Widgets and find your sidebar on the
right side.

e Step 4: On the left hand side you will see all the widgets you can use, simply
drag and drop the widget you want into your sidebar on the right hand site.

e Step 5: Make sure you click Save to save the widgets added to your sidebar.

RESTNRENN <iccbar Generator @ ==
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M Pages

Department Sidebar smk_sidebar 2fng [smk_sidebar id="smk_sidebar 2fng"]

¥ Comments (12
i#% Department
as Doctor

Grid Elements

B4 Contact

5|jdzl:ar Ger;;rator
Add Sidebar Widget

In addition to default WordPress widgets, Wemusic included Noo Recent News,
Noo Information, Noo Social and Noo Request Information widgets. You can add
any widget and any number of widgets into your sidebar. All widgets are
accessible from Appearance—> Widgets and easily dragged and dropped into your
sidebar.

e Step 1: Navigate to Appearance—> Widgets to access the list of widgets and
widget section that they can be added. The left hand side shows all the



widgets you can use. The right hand side shows all different sections you
can add widgets to.

e Step 2: Simply drag and drop the widget you want into the widgets section
on the right hand side.

e Step 3: Don’t forget to click save changes after you customize any widget
in sidebar.

Wemusic Widget Sidebar

Widgets are frequently used to create sidebar or footer. Beside default
WordPress widgets, Medicus added some sidebar widgets. To view all Widgets,
navigate to Appearance—> Widgets. You can drag and drop widgets from left
sidebar list into footer columns or sidebars as you want. Here is the list of

Wemusic Custom Widget you may want to use to have sidebar and footer like in
our demo site.

Noo Counter Social
This widget is used to count the number of customers subscribing you on social.

Noo Most View
Use this widget if you want to show all post which is most viewed by viewer.



MOST VIEW

Crossroads festival 2013 review

Backstage at coachella

Noo Information
This widget is used to show your contact information.

South Avenue a 34521 New York, USA

+84 123 456 789 Contact@wemusic.com

Noo Social
Use this widget if you want to show list social on footer position.



Noo Request Information
This widget is used to show Request information form on events page.

REQUEST INFORMATION

Want more information about
one of our featured events?

Noo Mail Chimps
This widget will help you to add subscribe form. It can be displayed on Footer of

page.

FOOTER

The Wemusic footer consists of the Footer Bottom and Footer Widget Area. Both
of these areas can be configured in Customizer on the Footer tab. The widget area
consists 4 columns in total, each column can have its own set of widget. You can
select to show 1,2,3,4 columns in the footer widget section. The following
sections will cover each of these aspects of footer.

DOCUMENTATION CREATED BY: NOOTHEME



ABOUT US TOP RATED PRODUCTS UPCOMING EVENTS SUBSCRIBE

WeMusic was built for Missic Band Event with Robinson Party AMY AND JOE'S REAL WEDDING Pellentesque at condimentum ligula. Donec nisi
selling ticket service dire :tly on site. Quick way to g frinfrfrd CELEBRATION nisi. porttitor a erat ac. fringilla ntum tellus.
popularize your events a1d make it more June 1-8:00 am-August 31-1100 am

professional towards thousands of audiences.

WORLD OF ART EXHIBITION 2015
June -8.00 pm-June 151000 pm

With responsive layout and advanced function. all
information is processed smoothly and designed to
enh ance event’s ticket shopping experiences.

Awesome Bass
frirfefy #ow)| ULTRA MUSIC FESTIVAL

ne 3-8-08 am-November 38-5:00 pm
Footer Widget Area

View More. ..

South Avenue a 34521 New York, USA 84123 456 789 Contact@wemusic com

Footer Bottom

Add Footer Widgets

e Step 1: From Admin panel, navigate to Customizer-> Footer, set the footer
column number from dropdown list. Number of columns can be from 1 to
4. You also can select None to leave it blank (no footer content).

e Step 2: To add widgets into footer, you can opt to add in Customizer 2>
Widgets tab directly or come back to Admin panel = Appearance
- Widgets.

e Step 3: In Customizer 2 Widget, you will see number of Noo — Footer
column #i tab corresponding to number of columns you select in step 1. In
each tab, hit Add a Widget button and choose Widget from widget list.

If you add widget in Appearance = Widgets, you will see Noo — Footer
Column #i widget section on the right hand side. Your widgets are located
on the left hand side. Simply drag and drop the widgets you want from the
left side into the sliding bar widget sections on the right side.

DOCUMENTATION CREATED BY: NOOTHEME



e Step 4: Don’t forget to save changes after you customize any widget in
footer.

VIDEO TUTORIAL

How To Import Demo Content

How To Install and Activate Theme

EXTRAS

Come together with Wemusic, these plugins are recommended to install and
activate for flexible use. Below are the source for documentation and support of
each plugins.

Visual Composer
Wemusic works well with Visual Composer, the popular drag and drop page

builder plugin with intuitive interface to build your content at ease. If you plan to

use Visual Composer Plugin for your site, check out these sources:

Visual Composer WordPress Plugin Documentation for user guide to use the

plugin.

Visual Composer WordPress Plugin Support System for support upon issues of

the plugin.

Contact Form 7
Wemusic is fully compatible with Contact Form 7, the free form plugin

recommended to create a nice form for your site. If you plan to use Contact Form

Plugin for your site, check out these sources:

Contact Form 7 Plugin Page for basic information about the plugin.

Contact Form 7 Plugin Documentation for user guide to use the plugin.

Contact Form 7 Plugin Support Forum for support upon issues of the plugin.



https://www.youtube.com/watch?v=O_7dmO18c8E&feature=youtu.be
https://www.youtube.com/watch?v=mJKBLEYIL5w&feature=youtu.be
http://kb.wpbakery.com/index.php?title=Visual_Composer
http://support.wpbakery.com/
http://wordpress.org/plugins/contact-form-7/
http://contactform7.com/docs/
http://wordpress.org/support/plugin/contact-form-7

The Event Calendar

Wemusic works well with The Event Calendar, the free plugin recommended to
show off your events in a calendar grid, list and day by day. If you plan to use The
Event Calendar Plugin for your site, check out these sources:

The Event Calendar Plugin Page for basic information about the plugin.

The Event Calendar Plugin Documentations for user guide to use the plugin.

The Event Calendar Plugin Support Forum for support upon issues of the plugin.

Woo Commerce
Wemusic works compatibly with Woo Commerce that allow you to create

membership package or online shop. If you plan to use Woo Commerce plugin for

your site, please check out these source:

Woo Commerce Plugin Documentation for user guide to use the plugin.

Woo Commerce Plugin Community Form for support upon issues of the plugin.

Woo Commerce Knowledge Base for question about plugin.

SUPPORT

When you come to this section, we hope that you found all the information
provided in this documentation helpful and you have finished installing and
polishing your site as what you have imagined of. After reading carefully this
guide, if you still need help, don’t hesitate to contact us at

http://support.nootheme.com.You will be asked to create an account if you are

new to us and enter purchase code to post a topic for support. To get your
purchase code, please login to your Themeforest account, navigate to
“Downloads”, click the “Download” button on the left of our theme, choose
“License Certificate” to download the license file where you can find the purchase

code.


https://theeventscalendar.com/product/wordpress-events-calendar/
https://theeventscalendar.com/plugin/the-events-calendar/
https://theeventscalendar.com/support/
http://docs.woothemes.com/documentation/plugins/woocommerce/
https://support.woothemes.com/hc/communities/public/topics
https://support.woothemes.com/hc/en-us/categories/200146917-WooCommerce
http://support.nootheme.com/

Please be noted to post a topic with your issues be clearly clarified. It is
recommended you send us together with link of your site and your admin
account. These will help to save time for both of us. Finally, please be patient. It

will take us some time to check all the topics and we will solve topics from older

to newest.

Hope you enjoy using Wemusic! Thank you for choosing our theme.
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